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Overview

Welcome to eCommunicate Desktop

eCommunicate Desktop allows you to easily send sms messages to individual contacts,
groups of contacts or both. You can schedule messages to be sent at a later time, and you
can also personalise messages - i.e add a contact field to an sms message, which will
automatically be replaced with the relevant contact field when the message is sent.

eCommunicate Desktop also includes an appointment and reminders feature which allows you
to enter appointments into a calendar and then have reminders sent out automatically,
depending on rules that you have setup.

For a more complete feature list, go here.

Getting Started

To get up and running check out the Getting Started topic.

· For instructions on how to send an sms check out Sending a simple SMS and Sending a
personalised SMS.

· For instructions on how to import contacts from existing source (e.g. Microsoft Outlook,
Outlook Express or Excel file) go here.

Thank you for using eCommunicate Desktop. Should you have any comments or queries
please feel free to contact us. Our contact details are listed here.

Created with the Standard Edition of HelpNDoc: Free CHM Help documentation generator

Features

With eCommunicate Desktop you can:

ü Send personalised sms messages to single contacts, large groups of contacts and once off
numbers (i.e. numbers that aren't even in your contact list).

ü Import contacts from existing sources including, MS Outlook, Outlook Express, Excel and
CSV files.

ü Import a list of messages to send from an Excel spreadsheet (each row contains the
number and message).

ü Easily manage contacts into groups
ü Advanced grouping functions: copy group/split group/move contacts from one group to

another
ü Schedule messages to be sent at a later time
ü View useful status information for each sent message, such as which numbers were

delivered and not delivered, and how many replies have been received.
ü Receive replies to sent messages, and see a list of all messages sent to and received from

this number.
ü The batch details report dialog shows additional information such as which numbers have

replied and which numbers have not replied for a given sms batch.
ü Organise individual contacts into groups - each contact can be in more than one group.
ü Save messages to be sent at a later time, for example if you are not connected to the

internet.

Unique feature highlights:

ü Summary view of sent messages allows you to easily see how many numbers were sent
successfully/failed. Then double click on message for more detailed information.

ü Send a (personalised) sms from any Excel spreadsheet without importing contacts into the
Address Book.

ü Enter appointments, anniversary and birthday information into a calendar.

http://www.helpndoc.com
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ü Automatically send out birthday, anniversary and appointment reminders based on pre-
defined rules.

ü Sync contacts or the entire database to multiple computers via the Dropbox integration
feature.

ü Send a scheduled birthday message to a list of contacts or groups in the address book, or
to contacts in an external database.

ü Enable email notifications for delivery receipts and replies.
ü Apply a junk filter to incoming shortcode messages.
ü Comprehensive replies report showing details such as time of day messages were received,

number of messages per day, per week and per month.

Created with the Standard Edition of HelpNDoc: Produce electronic books easily

License

eCommunicate Desktop License Agreement

You should carefully read the following terms and conditions before using eCommunicate
Desktop. Unless you have a different license agreement signed by eCommunicate, your use of
this software indicates your acceptance of this license agreement and warranty. If you do not
accept these terms you must cease using this software immediately.

Copyright

eCommunicate Desktop ("the Software") is copyright © 2010 by eCommunicate, all rights
reserved.

Restrictions

You are prohibited to modify, adapt, translate, reverse engineer, decompile or disassemble
the Software, or otherwise attempt to discover the source code of the Software.

Distribution

You are hereby licensed to distribute free of charge, the original installation file of the
Software without any modifications. You are specifically prohibited from charging for any such
copies.

Disclaimer of Warranty

THIS SOFTWARE AND THE ACCOMPANYING FILES ARE SOLD "AS IS" AND WITHOUT
WARRANTIES AS TO PERFORMANCE OF MERCHANTABILITY OR ANY OTHER WARRANTIES
WHETHER EXPRESSED OR IMPLIED. NO WARRANTY OF FITNESS FOR A PARTICULAR PURPOSE
IS OFFERED. GOOD DATA PROCESSING PROCEDURES DICTATE THAT ANY PROGRAM BE
THOROUGHLY TESTED WITH NON-CRITICAL DATA BEFORE RELYING ON IT. THE USER MUST
ASSUME THE ENTIRE RISK OF USING THE PROGRAM. 

Created with the Standard Edition of HelpNDoc: Easily create HTML Help documents

Getting Started
1. Setup account information in the Account Manager:

Before you can send an sms message you first need to create an account in the Account
Manager, available from under the Tools menu, or by clicking on the Accounts icon on the
main toolbar (which is visible when you are viewing the How To's section).

In the Account Manager click on Add Account. Fill in your account details in the relevant
fields:

http://www.helpndoc.com/create-epub-ebooks
http://www.helpndoc.com/feature-tour
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Before you can close the Account dialog, you need to verify your account details. Make sure
you are connected to the internet first, then press Verify. After the program confirms your
details are correct, you can press the OK button, to close the dialog. (The Account settings
topic explains the other fields that are available in the dialog).

2. Setup proxy server settings (if relevant):

If you are using a proxy sever to connect to the internet, you need to specify the proxy
details (in the Settings dialog) in order to be able to connect to the sms server. Fill in these
details in the Proxy server page of the Settings dialog.

3. Import contacts from existing sources (optional):

See the relevant topics that will guide you through the steps required to import contacts from
existing sources:

1. Import from Excel file
2. Import from MS Outlook
3. Import from Outlook Express

Created with the Standard Edition of HelpNDoc: Free help authoring environment

http://www.helpndoc.com/help-authoring-tool
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Purchasing credits
To purchase more credits, contact support via email (support@ecommunicate.co.za) or by
phone (011-443-6164).

After you have been informed that the requested credits have been added to your account,
click on "Refresh Credits" (on top menu bar) for the program to update the credits display.

(Note: The available credits display is also updated after you press "Send/Receive").

Created with the Standard Edition of HelpNDoc: Free iPhone documentation generator

Account settings

Account details

UserId, Password and ClientRef as provided by your administrator. You need to Verify (i.e.
click on the Verify Account button) these details before you can press OK to close the
dialog. "Verify Account" will check with the backend server that the details you have entered
are correct. Ensure you are connected to the internet before performing this check.

Options details

· Default country code: Country code number that will replace the initial "0" of a 10 digit
number. For e.g. If the Country code is "27" and you enter a recipient "0821234567", the
number will be sent to "27821234567".

· Sender ID: It is possible to setup a Sender ID for outgoing smses i.e. the text or number
that will appear on the recipients phone as the from number. Note the following rules that
apply to the Sender ID:

o A Sender ID cannot be used when sending to any South African cell numbers.
o A text Sender ID can only be setup by eCommunicate staff. 
o If you have setup a Sender ID to be used with an account, then you must enter this

field otherwise sending smses will fail (i.e. If it has been setup, then it is not
optional).

o If your Sender ID is text, then it will not be possible for the recipient to reply to your
message.

o A text Sender ID must be less than 12 characters. 
· Virtual SIM card: An extra field that can be setup by eCommunicate staff to ensure that

replies are correctly routed to your account.

Reply email addresses

In addition to receiving replies via the program, replies can also be received by up to 2 email

mailto:support@ecommunicate.co.za
http://www.helpndoc.com/feature-tour/iphone-website-generation
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addresses.

Created with the Standard Edition of HelpNDoc: Full-featured EPub generator

Importing
eCommunicate Desktop allows you to:
· import contacts from a variety of different sources into the Address Book. 
· You can also use external data and send messages directly without first importing into the

address book - see below.

Click the "Import" button on the main toolbar to bring up the "Select import option" dialog.
A brief explanation of each method is found below:

1. The most common way is to import contacts into the address book from various sources
such as Microsoft Excel files, Microsoft Outlook or CSV files. When you import you are
given the option to add the contacts to a new (or existing) group. The steps are described
in more detail in the Importing Contacts topic. (Click the link to go to that topic).

2. Compose an sms with custom fields from an Excel or CSV file, without having to import
the actual data into the Address Book. More details are explained here.

3. You can also import a list of numbers from an Excel or CSV file into a new sms message.
The message will be sent to all numbers in the list. It is not possible to personalise such a
message. 

4. Importing a list of messages from an Excel or CSV file. An Excel file contains a list of cell
numbers and messages. For every row, the given message is sent to the given cell
number. More details and requirements for the Excel file are explained here.

Created with the Standard Edition of HelpNDoc: Write EPub books for the iPad

Importing a list of messages from an Excel file

It is possible to import a list of messages from an Excel (or CSV) file. Each row in the
spreadsheet must include the destination cell number and message. After the spreadsheet is
loaded, each message will be sent as a separate sms to the cell number on that row.

This first line of the spreadsheet (the header row), must include labels for at least a "Cell
Number" and "Message" column. You can also include a "CCode" column to specify a country

http://www.helpndoc.com/create-epub-ebooks
http://www.helpndoc.com/create-epub-ebooks


eCommunicate Desktop 3

9 / 59

code for the numbers - otherwise the default country code that has been setup in the settings
dialog will be used for the numbers (if the numbers themselves do not include the country
code).

(Note:
You can also (optionally) include a "Unique ID" column. This column should have a unique
integer value for each entry. If this value is supplied, then it will be stored in the
eCommunicate database and associated with the given message. If at a later point you
export a report from the Sent Messages screen to an excel file (Export to XLS (Details)), the
delivery status as well as the original unique id will be included for each message. In this
way you can keep track of the status of sent messages in your own systems.)

The dialog that comes up allows you to view and confirm how many messages will be sent
and shows the associated cost. 

Scheduling Messages

You can click on the "Schedule Messages" button to schedule the messages to be sent at a
future date/time.

It is also possible to include a scheduled date for each message that is sent. (In this case
the "Schedule Messages" button is not available). To do this you need to have a column titled
"Send Date", and then the scheduled date for each message/row in this column. If you leave
this field blank for a given message, then it will not be scheduled - i.e. it will be sent
immediately.

Note:
When the program sends out individual messages it is much slower than sending out a single
message to a large batch of numbers. Therefore plan your imports and messages accordingly.

Unicode support

If the messages you are sending require support for unicode characters, then you need to
check the "support unicode characters" checkbox. Unicode characters include the special
characters from e.g. Portuguese and Spanish character sets. A single credit includes 160
normal characters but only 70 unicode characters. For more details click here to view the
"Sending a Unicode SMS topic".

Created with the Standard Edition of HelpNDoc: Easily create HTML Help documents

Create a personalised sms from Excel data

The second option under the import menu "Create a personalised sms from Excel data" allows
you to send a personalised (merge field) sms without having to import the data into the
Address Book first.

Requirements:
· The Excel file must contain a header row that describes what is in each column.
· The header labels must contain only plain English characters from a-z or numbers from 0-9.

They must not contain any other characters.
· There must be a column that contains the cell numbers.
· Data must be in the first sheet of the workbook.

How it works:

1. Click on the import button on the main toolbar.
2. Click on the button "Create a personalised sms from Excel data" and then select the file
you want to use/import.
3. In the dialog that pops up, the left section shows the data from the spreadsheet:

http://www.helpndoc.com/feature-tour
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You need to click on the drop down list and select which column contains the cell numbers.
After a valid column has been selected the "Select Cell Number" label will turn black. (Note:
The numbers will automatically be adjusted when importing).

4. You will notice on the right side of the dialog is the box to enter the message text. At the
bottom of the box you will find buttons corresponding to all the header fields in the
spreadsheet. 

When you click on one of these buttons the corresponding field will be entered into the
message. When the message is sent out, the field place-holder will be replaced by the
contents of the given column for the current row.

So if we have a spreadsheet that looks like this:
Mobile FirstName EmailAddress
0821230001 Joanna Joanna@gmail.com

then using the above sample message, the message that will be sent to "0821230001" will
be:
Hi Joanna, if your email address is not Joanna@gmail.com, then replay with... etc..

5. You can click on the "Schedule Message" button to schedule the message for a later time,
and lastly,
6. You can click on the "Preview Message" button to see a preview of what the first few
messages will look like, to ensure your message is correct.

When ready, press the "Send" button to send the message. As usual the message first goes
to the Outbox, and once sent will appear in the Sent Messages section.

Created with the Standard Edition of HelpNDoc: Create iPhone web-based documentation

How to split contacts from an Excel file into multiple groups

When importing a list of contacts from an Excel file you may want to split the contacts up
into smaller sub-groups for easier handling, e.g. Your Excel file contains 1000 contacts, and
you want these contacts to be imported as groups with only a 100 contacts in each group.

To do this, first follow the instructions here (how to Import from Excel file) to import all
contacts from the Excel into a main group. For this example, let's say the main group is called

http://www.helpndoc.com/feature-tour/iphone-website-generation
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"Main Group". Once you have finished importing the contacts, go to the Groups section.
Click on the desired group, then right click, then click on Split Group. Then enter how many
contacts you want in each group. (In this example we set the value to 100).

The Main Group will then be split into 10 smaller sub-groups with 100 contacts in each group,
as in the image below:

Created with the Standard Edition of HelpNDoc: Free help authoring tool

Importing Contacts

You can import contacts from:

Import from Excel or CSV

Import from  Outlook Express

Import from MS Outlook

Created with the Standard Edition of HelpNDoc: Free Kindle producer

Import from Excel file

1. Click on Import contact in the Main Tool bar

2. To import contacts into the Address Book, click on the "Import Contacts into Address Book
from..." menu item, and then click on (from) "MS Excel".

3. Locate the Excel file you want to import from and double click on it. After the file is
opened, you can select which sheet you want to import from by clicking on the provided drop
down list. (By default the first sheet is selected for importing). 

 

4. Map the columns of the spreadsheet to the field in the contact list by clicking the header of
any column that you want to import, and selecting the matching contact field from the drop
down list.

If you want to import additional custom fields from the Excel file (i.e fields besides the
standard firstname, lastname and cell number fields) you first need to setup the program to
handle extra custom fields. Click on the "Help Importing Custom Fields" link for assistance
for this task. Once you have setup the custom fields, you will see that these fields are

http://www.helpndoc.com/help-authoring-tool
http://www.helpndoc.com/feature-tour/create-ebooks-for-amazon-kindle
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available for selection in the column header drop down list.

5. After you press Continue, you are shown a summary of contacts that will be imported:

The dialog also shows the number of existing contacts in the Address Book (based on Cell
Number). If you want to update associated data (e.g. Title, Firstname, Lastname) for these
contacts, or assign additional groups to these contacts then keep "Update existing contacts"
checked. If you don't want associated data to be updated, then keep the checkbox unchecked.

6. In the next step, you have the option of assigning groups to the contacts. To do so,
simply click on the check box next to the group you want to assign the contacts to. If the
group does not yet exist: first click on "Add New Group". Type in the group name, then press
enter. A check (tick) is automatically added to this group. (It is also possible to specify the
desired groups in the Excel file itself. This is explained in the next help topic).

7. If you would like the contacts to be visible in your contact list, then Click next to Yes. If
you would like the contact not to be visible in your contact list then click next to No. Usually
you will want to just say "Yes", but if you are adding a large list, the you only want to send a
once off batch to, but don't want these numbers to become part of your day to day address
book, then click on "No". You can change the visibility of these contacts at a later point, by
simply re-importing and choosing a different answer. Then click "Continue".
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8. The contacts will then be imported. After the process completes you will be given the
option to check if all the contacts were imported successfully. If that was the case, then all
"New contacts" will move to the "Existing contacts" section of the import dialog. If for some
reason a number could not be imported, it will remain in the "New contacts" section.

9. Click "Close" to exit the import dialog.

Note:
To import from CSV files, the process is the same as importing from Excel files, except you
choose a csv file (file ending with an *.csv extension) instead of an xls file.

Created with the Standard Edition of HelpNDoc: Easily create EBooks

Specifying import group(s) in the Excel file

It is possible to specify which groups to import the contacts into in the Excel file itself. This
is done in the following way:

· Add a column for each group
· The first row should be labelled: "Group:GROUPNAME" (without the inverted commas). E.g.

"Group:Work Contacts". This will import the contacts to a group named "Work Contacts".
Alternatively, if you include the word "group" in the label (without the colon ":"), then the
full label text will be used for the group name. E.g. "Group 1". In this case the group name
will be "Group 1".

· For each contact (i.e. row) place an "X" in the given group column if you want the contact
to be added to that group. 

You can have as many group columns as needed.

Below is an example Excel file which illustrates the above points:

Created with the Standard Edition of HelpNDoc: Free Kindle producer

Import from MS Outlook

http://www.helpndoc.com/feature-tour
http://www.helpndoc.com/feature-tour/create-ebooks-for-amazon-kindle
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1. Click on Import contact in Main Toolbar

2. To import contacts into the Address Book, click on the "Import Contacts into Address Book
from..." menu item, and then click on (from) "MS Outlook". The following dialog may popup:

3. Check the "Allow access for" option, and then "Yes".

4. After you press Continue, you are shown a summary of contacts that will be imported:

The dialog also shows the number of existing contacts in the Address Book (based on Cell
Number). If you want to update associated data (e.g. Title, Firstname, Lastname) for these
contacts, or assign additional groups to these contacts then keep "Update existing contacts"
checked. If you don't want associated data to be updated, then keep the checkbox unchecked.

5. In the next step, you have the option of assigning groups to the contacts. To do so, simply
click on the check box next to the group you want to assign the contacts to. If the group does
not yet exist: first click on "Add New Group". Type in the group name, then press enter. A
check (tick) is automatically added to this group.
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6. If you would like the contacts to be visible in your contact list, then Click next to Yes. If
you would like the contact not to be visible in your contact list then click next to No. Usually
you will want to just say "Yes", but if you are adding a large list, the you only want to send a
once off batch to, but don't want these numbers to become part of your day to day address
book, then click on "No". You can change the visibility of these contacts at a later point, by
simply re-importing and choosing a different answer. Then click "Continue".

7. The contacts will then be imported. After the process completes you will be given the
option to check if all the contacts were imported successfully. If that was the case, then all
"New contacts" will move to the "Existing contacts" section of the import dialog. If for some
reason a number could not be imported, it will remain in the "New contacts" section.

8. Click "Close" to exit the import dialog.

Created with the Standard Edition of HelpNDoc: Create iPhone web-based documentation

Import from Outlook Express

Importing from Outlook Express is almost the same as Importing from MS Outlook.

To start the import process follow these steps:

· Click on "Import" on the main toolbar.
· Then move mouse over "Import Contacts into Address Book from..." menu item,
· then click on (from) "Outlook Express".

http://www.helpndoc.com/feature-tour/iphone-website-generation
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Follow the remaining steps as described in the Import from MS Outlook topic.

Created with the Standard Edition of HelpNDoc: Free Web Help generator

How to move contacts from one computer to another

Sometimes the need arises to move the contacts that you have on one computer to another.

You can do this by first exporting the contacts to an excel file from the one computer, and
then import them on the other computer.

Here are the steps involved in more detail:

Instructions to Export All Contacts:

1. Click on "Contacts" section on the left
2. Click on the "Export Contacts" button. This will prompt for a file name, and place to save
the file (like any usual save dialog). By default the file name is set to "Contacts.xls". Type in
a different file name if you are not happy with the default file name. Select the destination
folder where you want to save the file.
3. Press "Save". You should receive a message "File Saved Successfully"

Instructions to Export Groups:

1. Click on "Groups" section on the left
2. Click on the Group you want to export.
3. Click on the "Export Contacts" button. This will prompt for a file name, and you can also
select the location to save the file (like any usual save dialog). The program will set the file
name to the group name. If you are not happy with this, you can type in a different file name.
Select the destination folder where you want to save the file.
4. Press "Save". You should receive message "File Saved Successfully"

To export all groups, repeat the above process for all groups in the list.

Instructions to Import Contacts from an Excel file:

The help file contains instructions on how to import from excel file and microsoft outlook (the
process is almost the same in both cases). Please see these topics in the help file under
"Contacts"->"Importing Contacts".

Created with the Standard Edition of HelpNDoc: Easily create Help documents

Adding a new contact

1. Click on the Contacts Button on Side Bar.

2. Click on the New Contact Button on Main Toolbar.

3. Fill in the details and Click OK.

Created with the Standard Edition of HelpNDoc: Write eBooks for the Kindle

http://www.helpndoc.com
http://www.helpndoc.com/feature-tour
http://www.helpndoc.com/feature-tour/create-ebooks-for-amazon-kindle
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Editing Contacts

1. Click on the Contacts Button on Side Bar.

2. To find a contact, click on the letter that the contact's surname begins with to filter the
display, or click on the "Find" button, to search for a specific name/surname.

3. Click on the "Edit Contact" Button on the Main Toolbar, or simply double click on a contact
to edit it.

4. Edit the details that you wish to and Press OK.

Created with the Standard Edition of HelpNDoc: Produce Kindle eBooks easily

How to setup custom fields

The program by default includes a few essential fields for contact information such as
Firstname, Lastname, Cell Number etc.. It is however possible for you to setup your own
custom fields for the contacts.

Why would you want to setup custom fields?

This can be very useful. For example you could add a custom field Amount for each contact.
Then let's say you have a spreadsheet with contacts, and the amount that they owe (in an
amount column). You can import the data from the Amount column into the Amount custom
field. Then you can send a personalised message to these contacts such as:
"Dear {FirstName}, we would like to remind you that you have an outstanding amount of
{Amount} with us. Please settle this amount as soon as possible..." etc..

This would for example result in messages:
"Dear Fred, ... amount of R 50.00..."
"Dear John, ... amount of R 200.00..."

(The SMS dialog will guide you will inserting the correct personalisation fields).

So how to setup the custom fields?

Click on the "Settings" button to bring up the settings dialog. Locate the "Custom Fields"
tab. 
Then select the number of custom fields you want to use (You can use a maximum of 6) in
the spinedit control. Lastly enter the title for each custom field and then press OK.

http://www.helpndoc.com/feature-tour/create-ebooks-for-amazon-kindle
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If you then go to edit a contact (see Editing Contacts) you will see that the custom fields
that you setup are now available for you to use:

Note: 
· Once you have setup custom fields, they will also show up when you import data from an

Excel spreadsheet in the column picker drop down list. 
· When you personalise an sms in the "SMS dialog" (click on the large "Personalise" button)

these fields will be available to insert into the message.
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How to blacklist a number

To blacklist a number follow the instructions below:

1. Click on the "Contacts" button in the left panel:

2. Click on the "Blacklist number" button on the main toolbar:

http://www.helpndoc.com/feature-tour


eCommunicate Desktop 3

19 / 59

3. Follow the prompts in the dialog that pops up.

To view a list of all blacklisted numbers, go to the "Reports" menu item (on the top menu),
and click on the "Blacklisted Numbers" item.

Alternative method

It is also possible to blacklist/whitelist an existing contact by locating the contact (from the
contacts list) and then editing it's properties (i.e. Edit Contact):

Half way down, there is the option to "Exclude this contact from bulk messages". Check this
option to blacklist the contact or uncheck it to whitelist the contact.

See the next topic for information about the difference between a blacklisted and blocked
number.
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The difference between a blacklisted and blocked number

At this point it is useful to explain the difference between a blacklisted and blocked number.

In the context of the program you can blacklist a number meaning: this number will be
skipped if it is included in the recipients of a message. If you look in the message details (in
the Sent Messages section), this number will appear in the "Skipped" section - and not in the
failed numbers.

You can un-blacklist a number by either editing the details for that contact or using the
Blacklisted Numbers Report. (See previous topic).

A blocked number has a different meaning. Whenever a reply message with the text "STOP"
is received by the eCommunicate backend server, then that number will be blocked.
Irrespective of whether this number/contact is blacklisted in the program or not, any sms
message will not be sent by the eCommunicate Server to this number. Also, this number will
be listed in the failed numbers, and the reason for failure will be "blocked number".

It is not possible to un-block a number from the Desktop program. The only way this can be
achieved is to contact support, and ask them to do it for you.
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Connecting to an External Data source

Instead of importing contacts into the desktop Address Book, it is also possible to create a
connection to an external datasource (e.g. database), and then send smses to all contacts in
this connection.

This topic is covered in more detail here.
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Organising contacts into Groups

1. Click on the Groups Button in Sidebar

2. If you need to add a new group then click on the "New Group" Button in main Tool bar
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(and then type in a name for this group), otherwise select the group you want to work on
from the group list.

3. Click on "Manage Group".

4. In the Group Manager dialog, at first you will only see contacts in the current group. You
can select contacts and then remove them from the group by clicking on the "Remove from
Group" button. 

You can type in the edit box to find a specific contact, and also click on one of the button to
perform action mentioned in the image:

5. If you want to add contacts to the group, then click on the "Add Contacts to Group"
button. This will expand the dialog into two sides. Place a check next to the contacts you
want to add to the group (from the section on the right), then click on "Add to Group".
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Deleting a Group

1. Click on the group you wish to delete.

2. Click on the Delete Group button on the main toolbar. This will delete the Group, however
it will not delete any of the contacts in the group. (If you want to delete the Group plus all
contacts in the group then Right click (over the group grid). In the popup menu click on
"Delete Group and Contacts".)

3. When asked, "Are you sure you want to delete this group", click "Yes".
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Viewing contacts in a group

In the Groups section, the "Group Details" button toggles viewing all contacts in the current
Group:
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You can check contacts, and then move or copy them to another group (click on the relevant
buttons at the top), or click on remove to remove the checked contacts from the group.

You can also select contacts (without checking them) and then drag and drop them on to the
group you want to move them to. When you drag and drop contacts in this way, it works on
contacts that you have selected - not checked.
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Connecting to External Data

It is possible to create a connection to an external source of data (e.g. a MS Access Database
or MS Excel File), and then select to send smses to all contacts in this connection, just as you
would for a normal group. An external connection appears in the list of groups, and acts as a
special type of group.

In the "Groups" section, click on the "External Link" button. This will open the External
Datasource Connection dialog:

At the top of the dialog it says "Enter name for connection:". In the edit box enter a name
for this connection. (The connection will be displayed in the list of groups). Note: The name
must be unique.

To successfully setup the connection to an external datasource, you need to complete the
following 3 steps:

Step 1:
Configure an ADO Connection or Select a File. This is described in more detail here.

Step 2:
Select the required table from the datasource, or provide a custom SQL Query string. This is
described in more detail here.

Step 3:
The last step in setting up the connection, is to map the query fields to existing contact
fields. Click here for more details.

Options
Once you have completed the above steps, at the bottom of the dialog there are some
options that should also be setup for the connection:
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· Import data into Local Database
When sending smses to an external connection group, contact details are always loaded from
the external data source. However, it is advantageous to also import these contacts into the
local database, so that for example in the "Sent Messages" section and in various reports you
will have additional details for each number, such as First Name and Last Name.

· Country Code
It is important to select the correct Country Code to use for all numbers in the connection. If
there is a column in the table/query that specifies the country code for each individual
number, then this will be used instead of this default setting.

Sending SMSes to an External Link
Once you have setup all the required information you can close the dialog (Press OK).
Sending smses to (contacts in) an external link, works in the exact same way as sending
smses to a group. For example, in the SMS Dialog, click on the [Add to Recipients:] "Groups"
button, and then select the external link from the list of groups.
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Step 1: Configure the ADO Connection

The first step in setting up an external link is to configure an ADO Connection. ADO is the
name for one of Microsoft's database technologies (ActiveX Data Objects) which allows third-
party applications (like eCommunicate Desktop) to connect to a very broad range of
databases, as long as they come with an ADO driver. Many commonly used databases such as
MS Access or MS SQL Server can be accessed via ADO technology.

ADO also includes an older technology called ODBC. If a specific database does not have an
ADO driver, it can still be connected to via ODBC technology.

To connect to an external data source you have one of 2 options:

· Select a File
This option allows you to connect to MS Excel files (.xls) or MS Access Databases (.mdb).
Simply click on the "Select File" button and then locate and select the correct file using the
dialog. (Internally, this is really using the next option, i.e. an ADO connection is setup with
the correct parameters.)

· Configure an ADO connection
Click on the "Configure an ADO Connection" button. This will bring up the standard "Data Link
Properties" dialog, which allows you to setup an ADO Connection.

Here we describe how to setup an ADO Connection to a MS Access database, an Excel file,
and a SQL Server database.

1. Connecting to a MS Access database:
- Double click on the "Microsoft Jet 4.0 OLE DB Provider" option on the first tab. (This takes
you to the second tab). 
- In the provided edit box enter the path to the MS Access database file (.mdb).
- In the Connection tab, you can click on "Test Connection" to test that the connection is
working correctly. Once all is set, you can click on OK to close the dialog.

2. Connecting to an Excel file:
- Double click on the "Microsoft Jet 4.0 OLE DB Provider" option on the first tab. (This takes
you to the second tab). 
- In the provided edit box enter the path to the Excel file.
- In the last tab (All), double click on "Extended Properties".
- In the "Property Value" edit box, enter "Excel 8.0". Press OK to close.
- In the Connection tab, you can click on "Test Connection" to test that the connection is
working correctly. Once all is set, you can click on OK to close the dialog.
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N.B.: If you are connecting to an Excel file using the Jet engine you must make sure that it is
not open by MS Excel at the same time, since the Jet Engine only allows a single connection
at a time!

3. Connecting to a SQL Server database:
- Select the "SQL Server Native Client 10.0" option in the OLE DB Providers list.
- In the connection tab, for:

Step 1: Type "(local)" for a local connection, or type in the server name.
Step 2: Select and enter the appropriate security settings. (By default select use

Windows NT itegrated security.)
Step 3: Select the database.

- Click on "Test Connection" to test the connection is working ok.
- Click on OK to close the dialog.

Next step...
Once you have setup the ADO connection proceed to the next step.
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Step 2: Selecting a table

Once you have setup a valid ADO connection, the drop down list in "Step 2", will be filled with
all available tables from the database:

Click on the relevant drop down item, to select the desired table.

For advanced use:
If you require a specialized SQL query to select the contact data from more than one table,
click on the "Custom SQL Query" to enter and test this SQL Query.

Next step...
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Step 3: Map the query fields

As soon as you select a table from the drop down list or enter a sql query in Step 2, the grid
in Step 3 will be populated with records from that table/query:

The first row in the grid (below the drop down boxes), shows the header row/field values of
the table. I.e. title, firstname, lastname, etc. are the field names from the database.

Now you must click on the drop down arrows to select the correct matching field of the
desktop database - i.e. match "First Name" with [firstname], and "Cell Number" with [cell
number]. In this example the names for each field are almost identical. However in your case
they may be more different, e.g. your column with cell numbers may be called "Mobile No.'s" -
hence you need to tell the program which field is which.
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Once you have finished matching the relevant fields your grid should look something like this:

If you have setup custom fields for the application (see the "Settings" dialog - Custom
Fields), then these will be available from the drop down boxes.

You must at least provide a matching "Cell Number" column in order to send smses to the
listed contacts.

If you want to use the "Schedule Birthday Messages" function (from under the Tools menu),
then make sure to also map the birthday field.

Note:
If you need to see more columns in the grid, you can drag-stretch the dialog (i.e. place
mouse at edge of dialog, left click and then move mouse) to increase it's dimensions.

Once you have finished these steps, your external link connection should be ready to go.
Please see the end of the topic Connecting to External Data for information about the options
at the bottom of the dialog.

Created with the Standard Edition of HelpNDoc: Free help authoring environment

Sending a simple SMS

1. Click on the New Message button on the main toolbar:

2. To send an sms, you have to do 2 things:
· Write in the message text. You do this in the area indicated by the red arrow below.
· The second thing you have to do, is select/enter the people you want to send the message

to (see below).
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3. Here we describe 3 different scenarios, sending to:

A once off number (a number that is not necessarily on your contacts list):
Click on "Once off number"
Click on "Type in Numbers"
Type in the numbers
Press Ok

A Group:
Click on Groups
Place a check next to the group you want to send to
Press close or esc to exit

A Contact (from your contact list):
Click on contacts
Type in the edit box to search by First name, Last name or Cell number
Place a check next to the contact you want to send to.
Also, if there is only one contact in the list, pressing "Enter" to select this contact
Press close or esc to exit. If the edit box is empty, pressing "Enter" will also close the

dialog

Once selected, the contacts/groups/once off numbers should appear in the Recipients list, on
the right side of the SMS Message Dialog. The number of recipients (shown in the status bar
at the bottom of the dialog) and Total cost reflect the number of total recipients.

(Note: The exact number of recipients (i.e excluding duplicate numbers) - and therefore exact
cost - is only calculated when the message is actually sent)

Removing previously selected/added contacts

To remove an item in the Recipients list - right click on the one you want remove and click on
"Remove selected", or simply double click on the name.

When you are ready, click on "Send" to send the sms.

Tip:
You can also add a list of numbers to the "Once off Numbers" section from the clipboard:
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Copy the numbers to the clipboard in the original application (e.g. excel document or email),
then right click in the "Once off Recipients" section. A "Paste from Clipboard" button is
available. Click this to add the numbers from the clipboard.
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Adding a message footer

When sending a message you can select a predefined footer to add to the message. This bit
of text will be added to the end of the message that has been typed into the main message
area.

To select a footer, click on the drop down arrow, and then select one of the footers from the
drop down list. Once selected, the "characters" count, will also include the character count
from the footer.

To edit the list of available footers, click on the "Edit footer List" button (highlighted by red
square). This dialog allows you to easily add a footer to the list, edit the text of an existing
footer or remove a footer from the list. This dialog is also available from under the Tools
menu item (Setup Message Footers).

Setting up a default footer

At the bottom of the Footers dialog, are buttons to help you setup a default footer. Select
the desired footer from the list, then click on the "Set selected footer as default footer"
button. The display will update to show you that the selected footer is now set as the default
footer. When you create a new message, this footer will already be selected.

You can also see the option "Insert footer on a newline". If this option is selected, then the
footer will be added on a new line. If not, a space will be added before the footer.
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Using message templates

The message templates feature allows you to setup pre-made messages that can easily be
inserted into a new (blank) message.

You can access the Message Templates dialog from under the Tools menu item (Setup
Message Templates). 

For quick access you can also access template commands from the SMS dialog: from the
"Templates" tool button (on the icon toolbar), or by right clicking in the "Message Text"
area.
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How to create new templates

In the SMS dialog, "Create Template" will create a new template based on the text in the
message editor.

"Edit Templates" will open the Message Templates dialog, where you can add, edit or delete
templates.

In the Message Templates dialog, click on "Add Template" to add a new template. Each
template requires a title to identify itself. (Click on OK to save changes...)

How to insert templates

To insert a template into a message, right click in the message text area of the SMS dialog,
and move the mouse over the "Insert Template" item. Then you will see a list of all
available templates. Click on the desired item, and this will insert the template text into the
message body.

Note: When composing a message template you can insert personalisation fields, and these
will be filled out when you send the message (as per a normal personalised sms), provided
that you are sending to contacts in the Address Book and that these fields are present for the
given contacts.

Learn about message footers here.
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Scheduling a message

You can also schedule a message to be sent at a later time. Click on the "Schedule" button in
the SMS Message Dialog. Select the desired date and time and make sure the "Schedule this
message for" checkbox is checked. Then press OK.

When you send the message you will see it's scheduled status in the Sent Messages section.
Once a scheduled message is sent, credits are immediately deducted from your account.

It is possible to cancel a scheduled message, if it is still before the scheduled time. In this
case the credits will be reimbursed to your account.
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Sending a personalised SMS

When sending an SMS to one or more people, there is a feature offered which allows for each
person's name to be inserted into the SMS. The title, first name and/or surname can be
inserted into each SMS.

Note: These instructions apply to when you want to send a personalised message to contacts
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that are already in the address book. If you want to send a personalised message using data
from an Excel file, without importing the contacts into the address book please see this topic.

If you are sending the same SMS to 100 people but you want it to feel more personal, you
can use this feature since each person will have their name automatically added to the
message, giving it that "personal" touch.

How to send a Personalised SMS

1. Click on the "New message" button on the main toolbar:

2. Once the SMS dialog pops up, click on the "Personalise" button.

3. Click on the arrow next to "Insert Contact Field"

4. Refer to the instructions below, for the following scenarios:
If you would like to:
A) Insert the title, first name and surname 
B) Insert only first name 
C) Insert first name and surname 

 
An example for these are:

A) Mr. John Brown
B) John
C) John Brown

So for:
A) eg. Mr. John Brown:
             
              a)click on insert title     
              b) space bar
              c)Click on insert first name
              d)space bar
              e)Click on insert last name.

B) eg. John -click on insert first name   

C)eg. John Brown:
         a)Click on insert first name   
         b)space bar
         c)click on insert last name

If before the name is added you want it to say Dear (for e.g. Dear John) or To (for e.g. To
John), first type under message text "To" or "Dear" etc and only then click on Insert Name
etc.

Remember to put a space between each insertion! Otherwise it will look like this
DearMrJohnbrown.

To see a preview of what each message will look like, click on the "Preview Messages"
button.
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Sending a Unicode SMS

A standard SMS only allows you to send an sms with standard English alphabet characters.
You cannot for example send an sms with accented Portuguese or Spanish characters.
Additionally, you will not be able to type these characters in the SMS dialog (i.e. they are
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automatically removed).

In order to enable support for such extended characters you need to check the "Unicode"
checkbox in the SMS Dialog:

In this case, extended characters will not be removed from the message when you type them
in.

You should also bear in mind that when you send a Unicode message, the first 70 characters
cost a single credit (compared to 160 characters for a standard message), and thereafter
every 63 characters cost another credit.

So for example a Unicode message that is 130 characters will cost 3 credits (63+63+4).
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Quick SMS

Quick SMS provides a simple dialog for sending smses to a list of cell numbers that might be
in another program (e.g. email or excel), as well as to numbers from your address book.

Click the drop down arrow next to the "New Message" item on the main toolbar. Then click on
"Quick SMS".

This will bring up the Quick SMS dialog. Enter your message in the "Message Text" area. You
can optionally select a footer, in the same way as for a standard message. (See the topic: 
Adding a message footer for more details).

Type the cell numbers you want to send the message to in the "Cell Numbers" box. Each
number should be on a new line. Do not include any spaces or dashes in the number. 

You can enter either a 10 digit number that starts with "0" - and the default country code will
automatically be added to the beginning of the number (and the "0" removed), or include the
country code prefix at the beginning of the number (and remove the "0").

e.g. enter:
0821230011 or 27821230011.
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If the list of numbers is in another application (e.g. email or excel), then select the numbers,
copy (Ctrl+C), then click on the "Cell Numbers" box, and press paste (Ctrl+V).

To add a number from your address book: Right click on the "Cell Numbers" box. Click on
"Insert number from Address Book", and follow instructions to select a number and add it to
the list.

Finally, press "Send SMS" to send the message. Delivery status can be viewed in the "Sent
Messages" section. (See this topic: Viewing the status of sent messages for more details).
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SMS Cost Calculation

The final cost of an sms depends on a number of factors, listed below:

· Length of the message: E.g. if a message is less than 160 characters it will cost a single
credit. If it is more than this, it will cost more depending on the length of the message.

· If a message is marked Unicode or not. (Click here for more information on sending a
Unicode SMS).

· The total number of recipients.
· The destination location of cell numbers. E.g. an SMS to any South African location costs a

single credit. An SMS to a cell number in Angola costs 1.96 credits. A complete list of
location rates is available under the "Help" menu item (SMS Rates Table).
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SMS Confirmation Dialog

When you're reading to send an sms, click the "Send" button on the SMS Dialog. At this point
you will be prompted to confirm sending the sms, and also be informed as to recipient count
and credit cost.

Click OK to continue sending the message, or Cancel to cancel sending.

At the bottom of the dialog is an option to not show this confirmation dialog in future. Check
this option if you do not want to this dialog to appear in future.

How to re-enable the SMS confirmation dialog

If at some point you decide you would like to re-enable the SMS confirmation dialog, this can
be done in the Settings dialog, under the General tab.
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Viewing the status of sent messages

Once a message has been sent, you can go to the "Sent Messages" section to see the status
of sent messages.

1. Click on the "Sent Messages" button in the Side Bar
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2. The "Sent Messages" section is made up of 3 panels:

Panel 1: Gives summary information for every batch sent, including the current status of the
batch and also indicates how many messages are "waiting" i.e are still waiting for delivery
information, "delivered" - confirmed to have been delivered, and "failed" - definitely did not
reach the destination cell number.

Panel 2: Shows details of the message text.

Panel 3: Shows detailed information for every cell number in the current batch. For more
details on how this panel works see the next topic Delivery details of a sent message.

Explanation of the different status values of a message

The image above illustrates the different possible status values of a sent batch:
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Sent (Waiting for receipts) The server has sent the message to it's intended recipients.
However, delivery receipts have not yet been received for all
numbers in the batch, so it cannot be absolutely confirmed
that the message has been delivered.

To check for delivery receipts, click on the Refresh
Deliveries button on the main toolbar.

Sent (Complete) Delivery receipts have been received for the number of cell
numbers indicated in the Delivered column. To see the
details of which numbers have been delivered refer to Panel
3.

Note: If the status is Sent (Complete) and there are still
numbers in the "waiting" column, then it means that delivery
information is no longer available. Additionally, the cell will
have a white background, instead of a yellow background.
(I.e. the yellow background, indicates that we are still
waiting for delivery information for some numbers).

Scheduled A batch has been scheduled to be delivered at a future date.
If this date is still in the future, the batch can be Cancelled
(and credits will be reclaimed for the message. Note: You
must be connected to the internet in order to cancel a
batch). After the scheduled date arrives, the batch will be
sent off to it's recipients, and the status will change to 
Sent.

Cancelled If a scheduled (future dated) message was cancelled, then
the status will indicate this, and also show a count of how
many numbers were cancelled.

Failed All messages in the batch failed. This could be because all
numbers in the batch were invalid or blocked.
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Delivery details of a sent message

As mentioned in the previous topic, the bottom right grid in the Sent Messages section
(referred to there as "Panel 3"), displays detailed information for a given sent message batch:

If you right click anywhere on this grid, the popup will allow you to select which column (of
the current batch), you want to see details for: (You can also click on the drop down arrow, to
make the same selection).
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As you can see, for this batch there was 1 failed number. Let's see who it was: Click on the 
Failed item on the popup menu.

Now the title on top of the grid says "Details of Failed...", telling us that we are looking at
the details of numbers in the failed column. (The failed number was simply a test invalid
number).

In a similar way you can view details of Waiting and Delivered numbers for a given batch,
buy clicking on the corresponding item of the popup menu.
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The sent messages filter

At the top of the Sent Messages grid is a filter control that allows you to limit the display of
the grid:

As you can see from the image, if you click on the list drop down, you can select the time
period to display in combination with the number spin control, so e.g. 2 weeks, or 2 months,
or 4 months. You can all select "All Messages" to show all messages.

On the right end of the filter you can select to show all messages (in the selected time
frame), or just messages that are/were scheduled.
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Viewing replies

1. Click on the "Inbox" button in the Sidebar
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2.Click on the "Check Replies" button in the Main Toolbar.

You can also click on the "Send/Receive" button. This sends any pending messages (in the
outbox), checks for delivery receipts and then checks for any replies.
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Printing out and exporting messages

You can print out or export a report for a given message or range of messages.

Go to the Sent Messages section (or Replies section). Click on "Print" or "Export".

If you only what to print out/export a report of the current message, select the option "Print
out/export the currently selected message".

If you want to print out/export a range of messages then select that option. Now you can
select the start date and end date of the messages you want to include in the report.

Additionally, when printing, you can select the option "Show print preview before printing".
This will first show you a preview of what the print job will look like, and what it will include.
If you want to proceed - click on the print button in the preview dialog. The preview dialog
also allows you to export to various formats (See the buttons at the top left of the screen.) 
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Messages in the Outbox

Messages in the Outbox, are queued to be sent the next time you press Send/Receive, or
the program does a check to Send/Receive messages.

Messages will be queued if:
· You selected to Work Offline from the File menu
· You selected to Work Online, but there is no internet connection detected.
· You do not have enough credits to send a specific message.

To send messages in the Outbox, click on Send/Receive. If a message no longer needs to
be sent then you can delete it.
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Messages in Drafts

When composing a message in the SMS dialog, it is possible to Save the message to the
Drafts folder:

This means you can come back to edit the message at a later point, for example if there are
still some changes you would like to make to the message before sending it.

In the Drafts section, press Edit to continue editing the message in the SMS Dialog (and
then press Send when you're ready to send the message). You can also press Delete to
delete the message if required.
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Checking receipts/replies for multiple accounts

By default the program will only check for delivery receipts, replies and shortcodes of the 
currently active account when you click on "Send/Receive".

If you want to check for delivery receipts and replies of multiple accounts, then in the Account
Manager (under Tools->Account Manager), click on "Edit Selected" for each relevant account,
and then at the bottom of the Account settings, click on the option "Check for delivery
receipts and replies even if this account is not active".

If you want to check for shortcodes across multiple accounts, ensure the above option is
checked, and also make sure that the relevant shortcode campaign has been setup in the
Shortcode Campaign Manager (available under Tools).

If you want to see all incoming replies and shortcodes in the Inbox section, ensure that the
Inbox filter has been setup correctly (See the link "Click here to setup Inbox filter" in the top-
right of the Inbox section).
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Sending sms best practices

It is a good practice prior to sending a group SMS, to first send a test SMS to yourself. By
doing so, you ensure that you are satisfied with the presentation and formatting of the SMS.
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Scheduling a birthday message to contacts

The program has a Schedule Birthday Message function (under Tools), that enables you to
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schedule a birthday message for all contacts, or all contacts in a given group that have a
birthday in the specified time period - i.e. the coming week, 2 weeks or months.

Using the dialog should be quite straight-forward.

You can run the dialog multiple times since duplicate birthday messages will not be
generated each time, as long as you don't change the send time. I.e. the program checks to
see if this cell number has a scheduled message for the specified date and time, and if it
does, then it skips generating a duplicate message.

If you want to change the send time and you have already scheduled birthday messages,
then you should first cancel the existing messages (via the Sent Messages section), then
change the send time and re-schedule. 

Therefore it is best that you settle on a send time upfront, so that you will not have such
complications afterwards.

See also
Scheduling a birthday message to contacts in an external database
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Scheduling a birthday message to contacts in an external database

If you want to schedule birthday messages to contacts in an external database, you need to
do the following:

1. Create an External link group to the external data in the Groups section - more info here.
2. When you get to the step of mapping program fields to the external data fields, make sure

to also select which column contains the birthday dates:

3. Press OK to close the dialog.
4. Now you can use the Schedule Birthday Messages dialog as per usual (under Tools).
Select the recipients to specific group option, and select the group that you created in step 1.
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Overview

A number of reports are available from under the Reports main menu item. 

· Usage Overview Report - shows a chart view of messages sent per day for the selected
month.

· Message Report - shows a list of messages meeting the specified criteria - i.e time
period, message status, specified cell number.

· Duplicate Numbers

· Blacklisted Numbers - list of contacts/numbers which the program will not send sms
messages to.

· Failed Messages Report - list of messages that have a failed message status.

· Failed Numbers Report - shows a list of numbers and their failed message status. The
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previous report, shows the actual failed messages. This report focuses on which numbers
did not receive sms messages, and also shows how many times a specific number failed to
receive a message.

· Sent SMS Percentage Analysis Report - This report can give you a good overview over a
period of time as to how many message were definitely delivered, unconfirmed (presumed
to be sent but not confirmed..), and also failed. It also gives a report as to how many sms
replies contained a specific term (such as yes/no), and it gives the list of all messages
that match the "yes" term.

· Standard SMS Replies Report - detailed report of standard sms replies, showing how
many messages were received per day for selected period, time of day messages were
received, how many messages were received per week, and also per month (for last 9
months).

· Shortcode SMS Replies Report - detailed report of shortcode sms replies, showing how
many messages were received per day for selected period, time of day messages were
received, how many messages were received per week, and also per month (for last 9
months). More details in the next topic.
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Shortcode replies report

The Shortcode SMS Replies Report shows a detailed report of shortcode replies received in
a selected period including:

· how many messages were received per day for the selected period, 
· time of day messages were received, 
· how many messages were received per week, 
· and also per month (for last 9 months).

Before viewing the report you need to select which:

· shortcode campaign, 
· shortcode number(s) and
· keywords,

you want included in the report.

Once shown, you can press the button to save the report as a PDF file.
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Month View for Shortcode Replies Report
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Calendar Events Overview

eCommunicate Desktop includes a powerful feature that allows you to send out automated
reminder messages for appointments or birthdays that you enter into the calendar, depending
on rules that you have set up.

Once you have setup what reminder messages you want sent out for each appointment, all
you need to do is enter the appointment in the calendar and then the sms reminder
messages will be sent out automatically.

For example, you may want to setup 2 sms reminder rules for an appointment, so that for
every appointment made, a reminder goes out 1 day before, and then 1 hour before the
appointment. 

Every rule has a time which determines when the message will be sent (relative to the
appointment time), and a message - that you compose and will be sent to the client. The
message can be personalised for the client and include the appointment date or time, so for
example, a reminder message could say "Dear Mr Smith, just a gentle reminder that we are
expecting to see you tommorrow (Jan 23) for your dental appointment...".

These rules only need to be set up once, and then will be followed by the system
automatically. Of course, if at some point you want to change what your messages say or
when they are sent, this can be done by simply running the SMS Reminders Wizard again
(see Tools->SMS Reminders Wizard). Additionally, in the SMS Reminders Wizard there is a
global switch to turn off/on the reminder feature for appointments and birthdays respectively.

To run the SMS Reminders Wizard click on the "Reminders Wizard" button just above the
calendar: (If you don't see the Calendar, click on the Calendar and Events button on the left
panel)
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Important: 
Assuming you have set up your sms reminder rules, as soon as you make an appointment in
the calendar, the relevant sms reminder messages are scheduled and sent to the server
immediately. They will then be delivered to the client at the scheduled date. In other words,
the sms reminders work in the same was a scheduled/future dated sms. If you cancel the
appointment, the reminders will also be cancelled. Consequently, if you create/cancel an
appointment while not connected to the internet you will be prompted to connect to the
internet as soon as possible to send out the scheduled smses (if you created an
appointment) or cancel the scheduled smses (if you cancelled an appointment).
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Using the Calendar

The calendar allows you to  schedule a standard sms for a future date, or enter an
appointment (for which reminder messages will automatically be generated and sent out,
depending on the reminder rules you have set up).

Right-click on the day you want to add a scheduled message, or add an appointment: The
context menu pops up.

To schedule an sms message for this date, click on "Schedule SMS for Selected Date". You will
then be prompted to set the time for the message, select recipients and write the message
(in the standard sms dialog). Once you press "Send" you will see the scheduled message in
the calendar:

In the image above, the "(2)" in the hint balloon indicates the number of recipients. The text
in the calendar entry is in green, to distinguish it from from an appointment (which is in
black).

You can also see the message scheduled in the "Sent Messages" section. 

To add an appointment, click on the "Add Appointment" button. The Appointment Details
dialog pops up. Notice how the date for the appointment is already set to the date that you
clicked on in the calendar. All you need to do is select the contact who the appointment is for
(click on "Select Contact") and fill in the time (and duration) for the appointment (and
optionally add a comment if required/desired).
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Here you can see an appointment that has been setup for "Gillian Barne" at 2:00 p.m on 16th
March. The green tick indicates that reminder messages have been successfully sent out.

Once you have added an appointment, you will notice that if you then right-click on that day,
there will be additional popup menu items to edit or delete an event:

You can use these buttons to change details for an appointment (Edit Event) or delete the
appointment (Delete Event).

And lastly, clicking on the "View All Day Events" button will bring up the day view, which
allows you to view all appointments for the selected day in more detail.

See the next topic for more details.

(Note: If you double click on a day, it will also bring up the day view.)
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Using the Day View

The Day View shows the list of appointments for a given day aligned to their time slots:
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To add an appointment click (in the yellow area) on the time you want to make the
appointment. Then either click on the "Add Appointment" button on the top toolbar, or right-
click and click on the "Add Appointment at Selection" Button. The Appointment Details
dialog pops up, with the time already set to the previous selection. Enter the contact details
(Select Contact) and optionally add a comment. Then press OK (to close the dialog). The
appointment will only show up after you press "OK".

You can change the time of an appointment by selecting it: left click and hold the mouse
down. Then drag the appointment entry to a different time. 

You can also extend the appointment duration by doing the following:
- First click on the appointment
- Put the mouse at the (lower or upper) edge of the appointment box until you see the resize
cursor.
- Left click, hold down, and drag the border of the appointment box to extend it's duration.

To edit or delete an appointment: First select the appointment (left click on it), then press
the "Edit" or "Delete" button from the top menu, or the same buttons from the right click
popup menu.

Note: Changes will only be saved after you press the "OK" button.
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Setting rules

If you would like to change the set messages or the times the automated messages are to be
sent out:

1. Go to Tools 
2. Click on "Event types and Schedule rules"
3. There you can add a rule by clicking add
4. Rename it by clicking rename
5. Delete it by clicking delete (The predefined Event types, cannot be deleted, only modified.
Event types  that you create can also be deleted).
6. To edit the rules:

a) Highlight the Event type you wish to edit e.g. birthday,anniversary or appointment
b) Click on edit Rule

 
7. The time it is sent out can be either before or after the event
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The period can be either minutes, hours, days, weeks, months or years

Note: 
Birthday and Anniversary dates are set to 12 o'clock AM of the set date, so to send out a
birthday reminder at 8:00 am in the morning, you need to set the time period to 8 hours after
the event.

Birthday and Anniversary event types have a check next to "Annual Event". This means that
they recur annually.

8. To Change the message you can delete and type in whatever message you want under
Message text.
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How to create a scheduled message from the calendar

To create a scheduled sms from the calendar:

First go to the calendar section. Right click on the day you want to schedule the message for
and then click on "Schedule SMS for Selected Date".

In the dialog that comes up, select the desired time for the message to be sent, then press
OK. Now the usual SMS dialog comes up so that you can enter the message text and select
recipients. When ready, press "Send" to send the message.

You will then see the message scheduled in the calendar: (You can place the mouse over the
day to see a popup hint which contains a few more details about the message).
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Note: The message will also appear in the Sent Messages section, in the list of sent
messages.
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How to cancel a scheduled message from the calendar

To cancel a scheduled message from the calendar, right click on the day that the message is
scheduled for:

In the popup dialog you will see an option "Cancel Scheduled Message". In the submenu
under this item will be a list of all scheduled messages for that day. Click on the one that you
want to cancel.

You will then be shown a dialog with the message details and be prompted to confirm
cancelling the message. Click on Yes to confirm.
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Simple introduction

In a typical SMS shortcode campaign, you receive a large number of sms replies which all
come pouring into your Inbox. Usually you want to group the replies together based on the
message text – e.g. all people that replied “Yes” go into “Group 1”, and all people that
replied “No” go into “Group 2”. In this way you can then send a different “next step” message
to each group. This is exactly what the ShortCode Campaign Manager helps you do:

Ø Group together received shortcode replies based on the message text
Ø Send out pre-defined messages to each group.

Note: The campaign manager refers to each group as a Category.

So lets take a real life example. You are running a shortcode campaign, where people are
asked to reply in the suburb they live in. Based on this information you will then send a
message appropriate for their location. So for this campaign you will want to set up a number
of categories, and define filters for each category. For example: you want all messages that
contain the word “Germiston” to go into the Germiston category, and all messages that
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contain “JHB” to go into the “JHB” (Johannesburg) category. You can set up the filter to
contain numerous terms, and also include misspellings, so for example any sms that contains
“JHB” or “Joburg” or “Johanes” or “Johannes” will go into the “JHB” category.

In the Categories view, you can setup a different message for each category. You then send
out a message to a specified number of replies. (Often the business wants to send out their
smses staggered over time, so they send out a number of messages each day). The display
shows how many messages have been received for each category (for a selected time period),
how many have been replied to, and how many have not been replied to.

Table showing list of groups and number of messages in each group per shortcode
number.

Features:
· Easily set up groups for the messages to go into.
· Setup multiple text filters to control which group the message goes into.
· Setup predefined messages to send to each group.
· Control how many messages are replied to each time (manage replies in small batches).

Benefits:
ü Manage large numbers of replies by grouping them together.
ü Large amount of control on how to group messages.
ü Be freed of dealing with individual messages and instead deal with large numbers of

messages in a batch like fashion.
ü Time saving features: Setup a pre-defined message for each group.
Different display modes to highlight total number of messages received or just how many
messages still need to be replied to.
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Simple and Advanced modes

The campaign manager can work in a simple or advanced mode. 

In simple mode, you setup a number of keywords for each campaign. If an incoming
shortcode message matches a keyword, then it will be assigned (or grouped) to that keyword.
Each keyword can have a number of "aliases", i.e. a list of terms to match the given keyword.
Typically this list will include the keyword itself and mispellings of the keyword.

For example, we add the keyword "loan" to a campaign. Then we add a few mispellings to the
alias list, for e.g. "load, loen, laon", etc. Now if an incoming message contains any one of
these terms, it will be assigned to this keyword.

In advanced mode, the filtering system is more advanced. You setup a number of keyword
filters, and then combine them together into categories. So for example a category may be
called "Barber/Central JHB". Incoming messages will only be assigned to this category when
they match two filter, i.e. the barber filter, and central jhb filter.
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Setting up a shortcode campaign

To setup a campaign

1. Click on "Add new campaign" to create a new campaign.
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2. Fill in the relevant details for the supplied fields (Campaign name, shortcode, etc..).

3. Click "Add Keyword" to add a keyword filter. Once it has been added, add additional
misspellings for the keyword term (referred to as aliases). When an incoming shortcode
message matches any one of these terms, then it will be assigned to that keyword group.

To view campaign results

1. Select the campaign.

2. Click on Explore. You will see a list of all the keywords in the campaign, and how many
messages have been assigned to each keyword. Right-click in the grid display for further
options.

The general grouping denoted messages that have not matched any keywords.
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Technical introduction

The Shortcode Campaign Manager allows you to group incoming sms replies (that are
associated with a specific shortcode number) into pre-defined categories based on the
message text. In this way you can easily keep track of how many replies you are receiving for
a given shortcode number, and also send follow up messages to cell numbers in a specific
category.

Some initial setup for the campaign is required. You will need to create a number of
categories. However, the first step is to setup a number of filters since each category is made
up of a number of filters.

Let us give a simple example to make things easier to understand. An employment agency is
wanting to build up a list of people looking for employment. It places some advertisements
for people (looking for work) to send in an sms of their location and what job they are looking
for. (The advertisement gives some fixed options, let's say cleaner and barber.).

So as we receive sms messages, we want to know what location is the person from and what
job are they looking for. We need two filters: location and job.

For the sake of this example:
Location could contain the following options: Sandringham, Glenhazel, Lyndhurst
Job could contain: cleaner, barber.

So to setup a number of categories based on these filters we would have something like the
following:
Category #1: From Sandringham, For Cleaner.
Category #2: From Sandringham, For Barber.
Category #3: From Glenhazel, For Cleaner, etc.. etc..

You could also setup a category with only one filter. E.g:
Category #10: From Sandringham. (no job).

If a message does not contain any job term but does contain the location "sandringham",
then it will be placed into this category.

As you can see, you first decide what/how many different filters you need per message. Then,
you setup a number of categories by combining the filters together in different ways.

Note: If it is not clear what category a message should go into, e.g. it matches filters from
more than one category, then the message goes into a "General" category - i.e., a message
never goes into more than one category.

The above is just an example.

You could for example, filter each message based on suburb, province and city.
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Filter priority

When you setup the list of filters, you also assign a priority to each filter. What this means is
that if a message matches multiple filters (and so possibly matching multiple categories),
then the filter with the highest priority will "win", and messages will go into the category that
is using this filter.

Filters in practice

In practice, it may take some trial and error before you set up a list of optimal filters and
categories. Also, as you go along you may expand the various terms that a filter matches. As
you refine and make changes to your filters and categories, you can re-process existing
messages so that they may end up in different categories. You may especially want to re-
process the "General" category. (The General category is the place where messages go if they
do not match any other category.) In the Categories view, these actions are available from
the right-click menu.
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Creating a new campaign

To get started, open the Campaign Manager from under the Tools menu: Tools->Shortcode
Campaign Manager. The Campaign Manager can also be accessed from the How To's page.

Click on "Add New Campaign" to create a new campaign.

Follow these steps:

1. Enter the desired name for the campaign.

2. Enter the filter "classes" or types, that you want each message to be searched for, and
also each category to be comprised of. In the e.g. below, 2 filter classes have been entered
(Position and Location). Each category will be made up of a Position filter and a Location
filter. Optionally set a priority for each filter.

3. Enter the list of shortcodes being used for this campaign: (separate each shortcode with a
comma)

4. Enter you clientref and userid in the given fields.

5. You can optionally set a default message for the "General" category. In the categories view
(see next topics), you will have the option to right-click on the General category and send a
message to cell numbers in this category.
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Setting up filters

Once you have created a campaign, click on Explore to see the campaign details (i.e. filters,
categories, message counts). You can also double click on the campaign.
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Important: You first need to setup filter definitions before you can setup a category.

Click on the "Filters" button.

There are buttons to add/edit or delete a filter.

Each filter has a name and then a list of search terms that will be used to match an
incoming message with the filter.

For a Location filter, you may for example create the following filter definition:

Name: Northern Suburbs

Search Terms:
Sandringham
Rouxville

To have a more inclusive filter definition, you could setup the search terms to be:

Sandr
Roux

These would match:
Sandrinham, Sandringham, Sandrnham
Rouxvile, Rouxville etc.

(Since the filter match does not match a whole word only, but also if part of the search term
is present)
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Setting up categories

Once you have setup your filter definitions, you can then setup categories.

Click on the "Categories" button.

Then click on "Add New Category".

To setup a category, you select a pre-defined filter for each filter class/type, as in the image
below:

The category will then be named - referred to - according to it's included filters, e.g. Barber
\Rouxville.
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Working with categories
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Totals and category counts per shortcode are shown for the currently selected time period
(not shown in the image).

The counts shown represent: Replies received, messages sent, and in brackets - number of
messages that have not been replied to. The counts view can also be changed in the right
click menu to only show counts of messages that have not been replied to.

The right click menu, allows you to among other things:
· View messages that have been placed in the current category.
· Send message to numbers in the current category.
· Re-process the General category (if a message does not match all category filters, then it

gets dumped into the General category).
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Some important notes

Note:
When you send a message to a batch of numbers (in a category), the numbers will be taken
from the first numbers received in that category - not those from the current view.

For example, if you received 1000 messages on Monday, and then 1000 messages on
Tuesday. Now the time period you have selected is 1 day, so you are only seeing the counts
for Tuesday, then if you send a message to numbers from a category, it will be sending to
numbers from Monday first, before sending to numbers from Tuesday, even though Tuesday is
in view.

Created with the Standard Edition of HelpNDoc: Easily create PDF Help documents

Introduction

Using the Dropbox integration feature you can sync your contacts between multiple
computers. (You can also sync the entire database between computers but this has some
special requirements).

What is Dropbox?

Dropbox is a free service that lets you store documents and files "in the cloud" and also sync
these files between multiple computers and devices. A free account allows you to store up to
2 GB of data (although it is also possible to earn extra space in a number of ways).

Visit the Dropbox website for more information: www.dropbox.com

Initial setup

To get started with the Dropbox integration, the following steps are required:

· Create an account at the Dropbox website
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On each computer that will be syncing with Dropbox, do the following:
· Download the Dropbox software for Windows (You should find a "download" link on the

Dropbox website)
· Install the Dropbox software
· Setup the Dropbox software with the account you created above.

Option 1: All use the same Dropbox account

It is easiest if all computers use the same Dropbox account. In this case you only need to
specify the location of the base Dropbox folder in the Dropbox Integration settings. 

Option 2: Different users use a different Dropbox account

If a user (let's call him Jerry) is using a different Dropbox account from the "main" user, then
the "main" user must share his Dropbox eCommunicate folder with Jerry via the Dropbox
website. Jerry must accept the invitation to the shared folder, and then he must specify this
folder in the Dropbox Integration settings. I.e, once Jerry accepts the invitation, his computer
will have 2 eCommunicate folders. One named "eCommunicate" - created by the program by
default, and the second one will have a different name e.g. "eCommunicate (1)" or
"eCommunicate (2)" (since a folder cannot contain two sub-folders with the same name...).
He must specify that "eCommunicate (2)" (i.e. the shared folder) must be used for syncing
eCommunicate data.

Once you have setup the Dropbox software correctly, the next step is to setup the Dropbox
integration from within the eCommunicate Desktop program. This is explained in the next
step.
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Dropbox integration setup

First ensure you have setup the Dropbox software correctly (this is explained in the previous
step).

If you are just going to sync contacts, then the setup is easier, and all you need to do is
follow the steps below. If you want to sync the entire database, then be sure to read the
special requirements mentioned in the next topic: Important rules for full database sync.

Under Tools, click on Dropbox Integration.

Select Level 1 to sync contacts. (Select Level 2 to full database sync).

Enter the Dropbox folder location:
When you install the Dropbox software it creates a folder to store Dropbox files in. Select this
folder in edit box. This is the "base" Dropbox folder, i.e. the full path with end with
"Dropbox".

E.g. on Windows XP the path (i.e. folder location) should be something like this:
C:\Documents and Settings\UserName\My Documents\Dropbox

On Windows 7/8 the path should look like this:
C:\Users\UserName\Dropbox

Enter a Station Name

Under "Station name", enter a name for this computer. NB: This name must be unique within
your organisation. When the program updates from Dropbox you will see this label, and
therefore know from which computer the database is being updated.
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Important rules for full database sync

In-order for the Dropbox integration to work correctly and to ensure that no data loss occurs,
it is critical that:

1. The first computer you setup the Dropbox integration on, is the one that has all your data
on it. This database will be transferred to all other computers after they enable Dropbox
integration.

2. only one person is using the program at a time, 
3. and that each user:

o first restores the database from the Dropbox folder before commencing to use the
program and then

o saves (i.e. copies) the database to Dropbox when finished using the program (i.e.
making their changes).

Note: The above will happen automatically if the  "Copy the database to Dropbox when the
program closes" option is checked on each computer, and the program is closed each time
after using it.

However it is not essential that the program be closed each time after using it - as long as
the above mentioned cycle is maintained, i.e. the database is copied to Dropbox manually
with the "Copy to Dropbox" toolbutton (or a copy occurs via the timer..).

For example:

"A" enables Dropbox integration on his computer. The program will then prompt to copy the
database to Dropbox - click YES. "A" then works with the program. When finished he closes
the program. By default the database will be copied to Dropbox again.

"B" now opens the program, and enables the Dropbox integration. The database will be
updated from Dropbox. Makes some changes, closes the program - the database is copied
(i.e. saved) to Dropbox.

"A" opens the program. The database updates from Dropbox, so A now has all the changes
that B made to the database,

etc.. etc..

After you close the dialog...

When you press OK to close the dialog, if this is the first computer you are enabling Dropbox
integration for you will be prompted to copy the database to the Dropbox folder. Click Yes. If
this isn't the first computer click NO.

Please wait for the Dropbox sync to complete before enabling Dropbox integration on another
computer.

Note:
It is also possible for a user to copy the database to Dropbox manually via the toolbutton
next to the credits section.
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Syncing contacts

To sync your contacts with Dropbox first ensure you have setup the Dropbox integration
correctly.

To send/export contacts to Dropbox:

In the Contacts or Groups section click on the "Dropbox" main toolbar icon. This will send your
contacts to Dropbox.

To update contacts from Dropbox:
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Nothing need be done. The program will automatically update contacts from Dropbox when it
detects that a change to contacts has been submitted by other users.

Some extra notes on syncing contacts

1. Contacts are compared on the cell number field. I.e. it is assumed that the cell number is
unique for each contact. Therefore please ensure that there are no duplicate cell numbers
in your contact list. You can use the "Duplicate Number" report (under Report menu item)
to check for any duplicates.

2. Only new contacts and changes to contacts are synced via Dropbox. Deleted contacts are
not synced. So if you want to delete a contact or group, all users must perform the delete
on their workstation.
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Multiple Windows users sharing a single database

By default each different Windows user has it's data kept in a separate data file (i.e.
database). This means the account settings, contacts, groups and messages are kept
separately for each different Windows user.

(Note: We are not talking about people using different eCommunicate accounts within the
program - we are talking about different Windows users.)

It is possible however for different Windows users to all share the same data.

To do this go to the Settings dialog, General tab. Then select the "Use the same database
for all Windows users" option. 

In such case you should be aware of some important conditions for using this option:

· There can only be one instance of the program running at a time. The program cannot run
for two Windows users simultaneously. Before you switch to a different user, the program 
must first be closed down for the current user. (If users are not sharing the same data,
then you do not need to worry about this.)

· For a user to access the shared data, they must have sufficient Windows privileges to do
so. This may require that the user has administrator privileges (depending on which
version of Windows you are using). If a user does not have sufficient privileges then the
program will give an error when starting, stating that it cannot access the database file
because the user does not have sufficient privileges to read and modify the database file.

NOTE:
If you have been using different data for each user (as per the default), and then decide to
use shared data for all users, the new shared database file will not have data from the
respective Windows accounts. You will need to add your contacts, groups and account
information again. If required you can export your data to an Excel file and then re-import it
into the shared database file.
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Troubleshooting
If you are receiving error messages when trying to connect to the eCommunicate server,
the Diagnose Connection action can help provide extra information about the problem. See
here for more information.

If you are prompted by a warning from an anti-virus or firewall program, it is important that
you select the relevant option that will allow the program to run unhindered - otherwise it is
quite likely that the anti-virus or firewall program will interfere with the normal functioning of
the program.

The following sub-topics explain how to bypass possible warnings you may come across from
different anti-virus programs:

· Instructions on how to bypass warning from Avast Antivirus/Internet Security can be
found here. If you selected the wrong option with Avast Internet Security, then you may
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run into some problems. More details and instructions on how to deal with this are
explained here.

· Instructions on how to bypass warnings from Norton Antivirus/Internet Security can be
found here.

· Instructions on how to bypass warnings from Symantec Endpoint Protection can be
found here.

· Instructions on how to bypass warning from Microsoft Internet Explorer can be found
here.

· Instructions on how to bypass a firewall warning from AVG Internet Security can be
found here.

If you are unsure about a specific warning that comes up from your anti-virus or firewall
program please contact support for more information.
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Diagnose connection problems

If you experience error messages when trying to connect to the eCommunicate Server (for
example when checking credits), then the Diagnose Connection action can help by providing
extra information about the error, which will hopefully leas to its resolution.

The Diagnose Connection action can be found under the help menu item, or help toolbar
button. If there are problems, they will be highlighted in red. If there are no problems the
result will be shown in green. The results are  saved to the application log file, and can be
sent to support at a later time to help try and identify what the problem was. (From the Help
menu item->Send log to support).

If you experience problems connecting to the internet, it's a good idea to try connecting to
the internet with some other application (e.g. web-browser, or skype) to check that the
problem is specific to the application and not to your internet connection in general.

Here are some possible reasons for connection errors and relevant action to take:

· Weak internet connection. You do manage to connect to the internet but it keeps on
cutting out. Resolution: If you experience a cut out, try again later. In the long run, it is
important that you work with your service provider/telecommunications provider to try and
address the root cause of the problem to improve your internet connection, e.g replace
cables, identify electrical equipment that may be interfering with your internet connection,
etc.

· Temporary errors. Since connecting to the eCommunicate server involves a chain of
communication, it is possible that one of the links in the chain is temporarily down. If a
connection problem occurs try again later. If the problem persists, and you can connect to
other web based services without a problem (e.g. email, internet browser), please contact
support.

· Network errors, proxy errors. If you are connecting to the internet via a proxy/
intermediate computer, then ensure that your network and proxy are setup correctly to
allow you to connect with the eCommunicate server. Permission must be given to access
http(s)://messaging.ecommunicate.biz and sub urls. Usually your network administrator
will be the one to handle this issue. Proxy settings are entered in the "Proxy Server" tab
in the Settings dialog.

Important: 
In case of emergency, if the application is not working you can also send messages through
our website interface (if you are able to access the internet through a webbrowser). The
website address is: http://messaging.eCommunicate.biz/sms.
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single source

How to bypass Avast warning

With Avast Antivirus/Internet Security, you are likely to receive the following warning when
first running the program:

It is important NOT to select the default option.

Instead, click on the drop down arrow and select "Open normally" from the list.

You should also place a tick next to "Remember my answer for this program...".

Once you have made these selections, click on OK.

If you previously selected the "Open in sandbox" option, then click here for instructions on
how to correct the situation.
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Problems caused by Avast Internet Security

Some users have reported some strange behaviour of the program. Every time they restart
the application, they have to re-enter their client details. And also, all their data (contacts,
sent messages etc..) seems to disappear every time they restart the application.

In our experience this has been caused by Avast Internet Security. Initially it notifies the
user of a potential problem, and suggests that the program be opened in a "Sandbox". This
sandboxing is what causes the problems mentioned above.
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When this dialog first appears what should in fact be done (under ACTIONS TO TAKE) is to
select the "Open normally" option. Also make sure you tick "Remember my answer"...so
that you do not need to repeat this procedure in the future.

How do I fix this problem if I previously selected the "Sandbox" option?

· Open the main Avast Internet Security panel.
· Go to the the "Additional Protection" section.
· Click on the "Sandbox" section.
· Then click on the "Virtualized Processed" sub-section.
· There you should see that eCommunicate Desktop has been marked to "always run

virtualized".
· Click on the item in the list, and then select remove.
· Once you have removed the item from the list, the next time you run the program you

should be prompted as explained above. Follow the same steps as described there (i.e.
select the "Open normally" option.)
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How to bypass Norton AntiVirus warnings

You may receive a warning from Norton Internet Security or Norton 360 when trying to
download the setup file from the website:

To allow the download to proceed, click on the Run this program anyway button.

When you first try to run the setup file, you may receive the following warning from Norton
AntiVirus File Insight:

Click on Trust Now to allow the program to install.

Created with the Standard Edition of HelpNDoc: Single source CHM, PDF, DOC and HTML Help creation

How to bypass Symantec Endpoint Protection warnings

With Symantec Endpoint Protection, you may encounter the following warning after
downloading the setup file from the webiste:
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By default Symantec Endpoint Protection removes the file. (It says that it "has acted on the
risk"). To remedy, click on the More link.

A dialog then comes up with a button to "Allow this file". Click on this button to allow the file
"eCommunicateSetup.exe". Another confirmation dialog comes up after this:

Click on the OK button. The setup file will then be found in the location that it was originally
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downloaded to.
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How to bypass Microsoft Internet Explorer warnings

Some warnings may be received from Microsoft Internet Explorer when trying to run the
setup file after it had been downloaded from the website:

Click on the Actions button:

In the dialog that pops up, click on the More Options drop down button:

You will then have a button to Run Anyway. Click on this button to run the installation file.
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How to bypass AVG firewall warning

You may get the following warning from AVG when running the program:
"eCommunicate Desktop is trying to connect to the internet..." 

You should click on the "Allow (recommended)" option, as well as "Save my answer as a
permanent rule...". Then click OK.
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Failed message error codes

Below are error codes that are shown for failed messages in the Message Details dialog, that
shows details for a given message in Sent Messages.

Error code Error/Server message status Message
1 Invalid Invalid number
2 Cancelled Message cancelled
3 DELIVRD Delivered
4 UNDELIV Undeliverable
5 EXPIRED Sent. No confirmation delivery receipt (no

delivery receipt was received after 3 days)
6 UNKNOWN Result unknown
7 NOTAVAIL Message failed
8 REJECTD Message failed
9 INCORRECTFORMAT Invalid number
10 NOTINBATCHREF Message failed
11 NOINBATCHREFBATCHID Message failed
12 Failed Message failed
13 Blocked Blocked number
14 Undefined Undefined status code
15 NotEnoughCredits Insufficient credits to send message
16 ProblemWithCredits Problem with credits
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Support

If you require any further assistance please contact us.

Our contact details are as follows:

eCommunicate Support

Tel : 011 443 6164

Fax : 088 011 443 6164

email address: support@ecommunicate.co.za
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Credits

eCommunicate Desktop makes use of some excellent open source components. Thanks to the
authors of these components for making them available to the public:

· Jordan Russel - TB2000

· Alex Denisov - TBX package for TB2000

· Robert Lee - SpTBXLib package for TB2000 and TBX 

· Jim Kueneman - EasyListView
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